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Introduction 
 

The use of 3D digitisers in archaeological timber recording has become increasingly 
widespread in recent years. The Newport Medieval Ship Project currently utilizes four 
FaroArm Advantage 3D Digitisers to capture details from the 3000 timbers that 
comprise the medieval ship assemblage. This manual has been produced to help 
incoming staff understand how to set up and use the digitiser mentioned above.   
It is designed to help the timber recorder produce a final ship timber drawing that is 
accurate, consistent and polished in appearance. The guide should be referred to 
when questions concerning layer definitions or drawing tool choice arise. The timber 
recorder should endeavour to accurately capture all of the relevant details during the 
creation of the primary record, while remaining mindful of future intentions regarding 
the use of the record, including the production of three dimensional solid models (Both 
physical and virtual)(Figure 1). Attention to detail is paramount.  
 
This manual is meant to serve as a specific and detailed supplement to the ‘Faro 
Manual v.2’, by Dr. Fred Hocker. Please refer to Dr. Hocker’s Faro Manual (produced 
during work at the National Museum of Denmark Centre for Maritime Archaeology -
NMF) for detailed information and procedures concerning calibration, digitiser 
alignment, layer management, and control point installation.  

Figure 1. Rhino 3dm file of forward most section of keelson with lofted treenails 
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Preparing the Timber and Recording Apparatus: 
 
Turn on your brain--Ask yourself ‘why are we recording the ship?’  
 

Figure 2. Preparing the recording table for use. Inset: FaroArm mounting ring. 
 
Prepare recording table. Sweep away debris, position breeze blocks and padding if 
necessary, make sure caster wheel brakes are on, check plugs and cables (both 
ends) on all equipment, turn on and position lights, lay out pins, probes and tools. 
Ensure floor mat is properly positioned. It is easier to do these tasks before the timber 
is placed on the table (Figure 2). A quality wireless (Bluetooth s
keyboard and mouse are essential. 
Setting Up the Faro Arm 
Open the Faro Arm case and take an inventory. The base of 
the Faro Arm has an oversize female threaded locking ring, 
which attaches to a male screw ring that can be through 
bolted to a sturdy metal table or other hard and stable 
surface (Figure 2-Inset, 3). These rings can be attached 
along the back edge of a recording table, allowing the arm to 
be quickly and easily moved when recording long timbers. Alternatively, the rings can 
be mounted to a piece of plate steel and then that plate clamped to an available hard 
surface. Inorganic surfaces have been found to be more suitable, as the dimensions of 
organic materials, like wood, can fluctuate with changes in humidity and temperature. 
It is important the arm be firmly fastened to the recording surface, and that the object 
being recorded and the base of the Faro Arm are not moved whilst recording is in 
progress. Ensure that the arm is firmly clamped to the table by turning the locking ring 
approximately one sixteenth of a turn past hand tight. It has been found that adding a 
column or extension to the base of the Faro Arm extends the  

eems to work best) 
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   Figure 3. The mounting of the arm.      Figure 4. Counterbalance in action. 

balance system, making it easier and less 
The counter balance system consists of a 

retched taut between two beams projecting 

 
reach and positively affects the counter 
tiring to draw larger pieces (Figure 3). 
wheeled carriage that runs along a cable st
forward from the rear of the table (Figure 4). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 5. Detail of carriage, counterbalance,   Figure 6. Detail of probe in use. 
and probe tips (clockwise from top left). 
 



Place the timber on the recording table and stabilize as necessary. Place plastisote 
foam wedges under the timber in such a way as to support the timber without 
deforming it. Breeze blocks or bricks can be used if additional support or bracing is 
required. If possible, centre timber on table so that the entire face can be reached 
without repositioning either the timber or the FaroArm. Some small fragments may be 
so light that they require a sort of clamping system to remain immobilised. Try placing 
timber on a bed of Styrofoam, polystyrene, or plastisote, and then cut wedges that can 
be pinned to the underlying bed while bracketing the fragment. This setup is similar to 
ones used by machinists clamping metal to a milling machine bed (Figure 7).  

 
 
When recording planks, begin with the inboard face facing up, with the upper edge of 
the plank towards the back edge of the table. On a port side plank, the forward end will 
be on the right, and on a starboard plank, the forward end will be on the left. Critically 
think about the orientation and visualize where the timber would fit in the hull of the 
vessel as if you were standing on the keelson facing the bow. It helps to virtually put 
yourself inside the vessel. Note any unusual features and read over the timber sheet 
notes made during the cleaning process. Keep timber hydrated by spraying 
periodically with spray bottles filled with clean cold tap water. Cover the timber with 
wetted capillary matting when not actively recording.  
 
 
 
 
 
 

Figure 7. Preparing to record a small fragment that has been rendered immovable. 
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Installation of Control Points  
A minimum of three control points are necessary to accurately orient the FaroArm 
probe tip to the timber. Using an electric drill, insert A4 or SS 316 (marine grade 
stainless steel) control points (cross hatched (Phillips) wood screws) along both edges 
of the plank (approximately every 10 to 25 cm along each plank edge), or on the 
inboard and outboard face of 4 sided timbers (assuming the timber represent a joggled 
frame with curvature). If a screw begins to strip, stop immediately and reverse the drill. 
Use pliers if necessary to remove the screw, and try again. Control points should be 
placed where the timber edge is thicker than 10 mm. Disarticulated pieces require 
additional control points, while areas of sapwood should be avoided (although longer 
screws may be placed in these areas if necessary). As a general rule, the more 
flexible the timber, the more closely spaced the control points. Control points 
are cheap and easy to shoot in, and immensely valuable later on. Use liberally! 
ALWAYS USE MARINE GRADE STAINLESS STEEL! USE COWTAGS INSTEAD 
OF TYVEK LABELS WHENEVER POSSIBLE! 
 
Start Up 
Turn on computer, FaroArm, and monitor. Carefully remove FaroArm dust cover. 
Arrange wireless keyboard and mouse, connect if necessary. Ignore the low battery 
signal until the mouse and keyboard actually stop working. Open appropriate Rhino 
template (2 sided or 4 sided timber) from the template folder on the desktop. Save file 
in the Recorded Timbers folder as a 3-4 digit cow tag number followed by the function 
code.  
Example:  ‘945 F33_0’ can be found in the Recorded Timbers\Frames\Frame 33.  
Example: ‘404 P9_9’ can be found in Recorded Timbers\Planks\P9.  
 
Connecting the Digitiser 
In Rhino, Click on Connect Digitiser icon 
Select digitizer: (D
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Installation of Control Points  
A minimum of three control points are necessary to accurately orient the FaroArm 
probe tip to the timber. Using an electric drill, insert A4 or SS 316 (marine grade 
stainless steel) control points (cross hatched (Phillips) wood screws) along both edges 
of the plank (approximately every 10 to 25 cm along each plank edge), or on the 
inboard and outboard face of 4 sided timbers (assuming the timber represent a joggled 
frame with curvature). If a screw begins to strip, stop immediately and reverse the drill. 
Use pliers if necessary to remove the screw, and try again. Control points should be 
placed where the timber edge is thicker than 10 mm. Disarticulated pieces require 
additional control points, while areas of sapwood should be avoided (although longer 
screws may be placed in these areas if necessary). As a general rule, the more 
flexible the timber, the more closely spaced the control points. Control points 
are cheap and easy to shoot in, and immensely valuable later on. Use liberally! 
ALWAYS USE MARINE GRADE STAINLESS STEEL! USE COWTAGS INSTEAD 
OF TYVEK LABELS WHENEVER POSSIBLE! 
 
Start Up 
Turn on computer, FaroArm, and monitor. Carefully remove FaroArm dust cover. 
Arrange wireless keyboard and mouse, connect if necessary. Ignore the low battery 
signal until the mouse and keyboard actually stop working. Open appropriate Rhino 
template (2 sided or 4 sided timber) from the template folder on the desktop. Save file 
in the Recorded Timbers folder as a 3-4 digit cow tag number followed by the function 
code.  
Example:  ‘945 F33_0’ can be found in the Recorded Timbers\Frames\Frame 33.  
Example: ‘404 P9_9’ can be found in Recorded Timbers\Planks\P9.  
 
Connecting the Digitiser 
In Rhino, Click on Connect Digitiser icon 
Select digitizer: (Digitizer=FaroUSBDigitizer): Press enter.  

 
 
 
 
 
 
 
 
 
 

Exercise the FaroArm by rotating the joints until the red light on the probe grip stops 
flashing. Check probe tip and replace if worn or damaged. Hook arm into spring 
balance. Ensure that spring balance carriage is properly attached to overhead cable. 
Remove protective foam boot from probe tip. 
 
Calibrate FaroArm probe once per week using the ball probe on the calibration block. 
Faro>>Calibrate Probes>>Sphere Calibration--Follow Onscreen Commands. You 
must also calibrate the FaroArm probe after replacing or adjusting the probe tip or 
moving the FaroArm or the timber. 
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If this is the first time the timber has been recorded, you must create a work plane (see 
below).  At the Enter Origin with digitizer 
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Front edge of Recording Table, in plan view 

1st point (Origin) 

3rd point (Y) 

2nd point (X) 

prompt, do the following to create the work 
plane:  
 

 
 
 
 
 
 
 
 
 

 
Define the plane by choosing a point (visualize a capital ‘L’) on the surface of the table 

 the second point at the right 
’.  Rhino will then 

n the 

Figure 8. Defining the work plane and origin. 
 
 
Check orientation of FaroArm to work plane. Press F3 (DigSketch) to make the cursor 
appear. In the top view, the cursor on the screen should move upwards when you 
move the FaroArm probe tip towards the back of the table. Also check right to left 
motion.  
 
 
 

(Figure 8). Make the first point the corner of the ‘L’. Mark
end of the lower leg, and mark the third point at the top of the ‘L
prompt you to enter the world origin (0,0,0). Press Enter. The distance betwee
three points is not important, however the angle is, so try to get as close as possible to 
90 degrees. 
 



Capturing Data with the Faro Arm (Recording the Timber) 
 

 
Figure 9. Recording a mast step brace using the FaroArm.  
 
The details of the ship timbers are systematically recorded with the aid of the layering 
system. Ensure that the details of each face have been completely recorded in the 
proper layer before moving on to a new side, otherwise, it will be necessary to reorient 
the FaroArm to the timber. It may take some experimentation to find a comfortable grip 
that best suits handling the Faro Arm (Figure 9). It helps to hold one hand near the 
probe tip, using this hand and fingers to control the motion and location of the probe 
tip while using the other hand to push the buttons. The fingers can be used as 
‘outriggers’ for helping to accurately trace edges and surface detail like grain and 
cross sections. It often helps to warm up your muscles by spending a minute or two 
tracing along the edge of the recording table with the probe tip. Care should be taken 
to keep the probe tip from damaging the surface of the timber. Tread lightly! As most 
people are right hand dominant, the work stations have been set up to accommodate 
them, as they tend to work from left to right when recording the timber, although the 
FaroArm and recording table can be configured to work just as well in the opposite 
direction. 
 
MEASURING TAPE 
Choose MEASURING TAPE layer (aa01). Click on single point tool icon. Place 
FaroArm probe tip in circled depressions along front edge of recording table, shooting 
in a point every 50 cm. Press green button once and followed by red button. This 
sequence takes the point and resets the chosen tool, allowing another point to be shot 
in using the green button. Measuring points do not need to extend beyond the extents 
of the timber. These points provide an internal scale that might prove useful if the 
external scaling became unstable in the Rhino software program. 
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Change to the aa02 layer and shoot in the CONTROL POINTS using the single point 
tool. Place probe tip squarely in the bottom of the cross hatching of the Phillips screw 
head. Be careful to only shoot in one point for each control screw. Apply only enough 
pressure to seat the probe tip against the screw, as excessive pressure may cause the 
timber to shift.  
 
REORIENTATION 
When it is necessary to reorient the FaroArm to the timber (i.e. turning a timber over or 
accidentally bumping it), choose the Calibrate Digitiser icon and, at the Enter Origin 
with digitizer prompt, shoot in three control points (ideally widely spaced apart along 
both sides of the timber, forming a triangle). Using the mouse, set the Osnap (Object 
Snap) to ‘point’ and click on the three control points in the same order as they were 
shot in with the FaroArm. Control point tolerances should be under 4/10 of one 
millimetre (0.4 mm). Shooting in the control points within tolerances is necessary 
whenever the timber or the FaroArm is moved (even the slightest bump to the timber 
requires shooting in the control points again). Please read Dr. Fred Hocker’s Faro 
Manual v.2 for more information on the use of control points and the useful and 
important technique of ‘leap frogging.’ (Also see end of this manual). 
 
LABEL LAYER 
Select the polyline tool (the icon with 
three points connected by two lines) and 
shoot in corners of the yellow cow tag in 
the aa04 LABEL layer. You should 
shoot in 8 points, and then type the 
letter ‘c’ and press enter. This action will 
close the polyline (i.e. connect the all of 
the points with a continuous line). Then 
click on Dimensions/Text Block. In the 
main field, enter the cow tag number (3-
4 digits). Select Arial and 10-20 
millimetres and press Enter. Place this 
text on the timber surface with the 
FaroArm or mouse, watching the 
monitor until the text is centred within 
the outline of the cow tag. 
 
The drawing should also be signed in this laye
cow tag number, followed by t
press Enter. Then place this text (using the mouse) in the lower right hand corner of 
the drawing, immediately under the measuring tape.  
(Example: 563   P2_5   Toby N. Jones   27 August 2005) 
 
Additional Labels: Use the label layer to mark the location of frame ends. Use the 
polyline tool and same text settings, except choose 10 mm font size. 
 
Note: It is important to look under all labels for hidden fasteners and features.  
 
 

*SAVE YOUR WORK EVERY TIME YOU CHANGE LAYERS (Press F5)*

r: Using the same text settings, type the 
he function code, the recorder’s name, and the date and 
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RECORDING EDGES 
 
Begin with the inboard or X face of the timber. Select the DigSketch tool by pressing 
F3. Check settings of the DigSketch tool and ensure that the following parameters are 
selected: Points=No, Curve=No, Polyline=Yes, Planar=No, Point Spacing=1 
 
It is important to ensure that you are drawing DEGREE 1 curves. Any other 
degree involves the computer generating curves to fit best fit the points, and 
results in corners becoming softened or rounded.  
 

of edges and damage. The following layers should all be drawn using the DigSketch 
tool (F3). Take care to avoid unnecessary line breaks. Please check the parameters 
often as they are easy to inadvertently change. The future uses of the digitised timber 
drawings necessitate the termination of all lines into other lines. There shouldn’t be 
any naked edges (lines that end in space rather than connecting to another line). This 
is especially important when recording edges. In Rhino, edges define surfaces, and 
without a continuous edge containing the surface, the surface is invalid. 
 
ORIGINAL EDGES, LIMITS, AND DAMAGE: 
 
cc01 SAPWOOD: Define the heartwood/sapwood boundary 
 
cc02 ORIGINAL EDGES: Where an original surface meets another original surface. 
 
cc03 LIMITS OF ORIGINAL EDGES: Where an original surface meets a damaged or 

otherwise non-original surface (including teredo boring, erosion, or piling/coring 
damage and cracks or splits over 1 mm in width). 

 
cc04 DAMAGED EDGES: Where two non-original surfaces meet. 
 
cc05 ORIGINAL DAMAGE: Damage caused during construction/use-life of vessel, 

i.e. hammer dents and nail gouges. An axe can cause the peeling or pulling of 
wood grain around a knot.  

 
cd01 LAND: On planks, record the upper edge of the land on the inboard face and 

lower edge of the land on the outboard face. 
 
 

*SAVE YOUR WORK EVERY TIME YOU CHANGE LAYERS (Press F5)*

 
Trace edges of timber in the layers outlined below. Please refer to following definitions 

 
 
 



cd02  CRACKS: Use DigSketch (F3) to draw cracks that are less than 1 mm in width. 
These cracks often emanate from nail holes. Larger cracks should be drawn 
using the LIMITS OF ORIGINAL EDGES layer (cc03).  

 
cd03 GRAIN: Trace the wood grain using the DigSketch tool. On a plank, draw at 

least 2 lines of representative wood grain extending the length of the plank. 
Also note any knots or unusual rays. Draw end grain and rings if possible. Draw 
as much grain as is feasible on four sided timbers.  Draw grain on treenails and 
wooden nails if possible.  

 
RECORDING FASTENERS 
 
cf01 ADDITIONAL NAILS: Any non-clenched nail. Often used for repairs. Look for 

small nails on scarves and along edges of planks. Draw the shaft of the nail 
with the polyline tool. You should close a polyline by pressing ‘c’ and enter after 
placing a point at each angle along the edge. Centres can be automatically 
placed on objects that are constructed using a closed polyline. All 
corresponding nail angle centres should be connected with a polyline, ideally on 
a new layer, as this will aid the creation of fastener holes during modelling. 

 
cf02 CLINKER NAILS AND ROVES: Draw the rivet (nail shaft) using the polyline 

tool. You should close a polyline by pressing ‘c’ and enter after placing a point 
at each angle along the edge. The rove and nail head can be recorded using 
DigSketch, and then a short polyline segment used to bridge the gap. It helps to 
place a pin along the edge of the fastener, so you have a well defined starting 
and stopping point. Track your progress along a plank by moving a plastic ruler 
while you record. Deeper roves can be recorded by drawing an additional line 
along the upper edge of the impression, or by defining the edge with snit. 

 
cf03 NAIL ANGLES (and centres): Place the 15 cm metal rod into the fastener hole. 

Where the rod emerges, start the polyline and place the end of the line on the 
top of the metal rod. By later subtracting this length from 15 cm, it is possible to 
determine the depth and angle of the fastener. If the fastener/corrosion product 
has completely filled the hole, place rod on the surface and create the line. A 15 
cm line will indicate that the hole is plugged. Try to make the angle as accurate 
as possible. Make a note on the timber recording sheet if the nail angles and/or 
depths are suspect. If you use a different length rod, please note it on the 
timber sheet. 

  
 This layer is also used to mark the centre of each metallic fastener.  
 Choose single point tool and highlight ‘Cen’ (center) from the Osnap (Object 

Snap) tool bar. Using mouse, place cursor near centre of rivet outline, after it 
has been closed. Rhino will automatically determine the centre. Click left mouse 
button to place the centre point, followed by right mouse button, in order to 
reset the tool. HINT:  If you draw a polyline (on a new layer) between the 
inboard and outboard fastener centres, it will save you time when making 
the fasteners in the solid modelling phase. 

 
 

*SAVE YOUR WORK EVERY TIME YOU CHANGE LAYERS (Press F5)* 
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cf04 CONCRETIONS: Draw extents of concretions using either DigSketch or 
polyline. Note: you cannot ‘close’ a DigSketched line. If you want to ‘close’ a 
shape, you must draw it with polyline and press ‘c’ followed by enter after 
plotting the last point. 

  
cg01 TREENAILS: Record Treenail shape, or hole if treenail is missing. Look for 

wedges and construction features, like a truncated head, or a dimple in the 
centre, or knurling around the edges of the shaft. Draw any dimples using the 
polyline or circle tool. It is useful to start in the same position every time…for 
instance visualizing  a virtual clock face over the fastener and starting at 6 
o’clock and working clockwise, taking a point every 0.5 to 1 hour, i.e 12-24 
points around the fastener. Insert a pin to provide a defined starting and 
stopping point. 

 
cg02 WOODEN SPIKES AND PLUGGED HOLES:  including wooden spike filled iron 

nail holes. Draw top and bottom of visible fastener (one point in each corner),  
with the polyline tool, and then connect the planes with four poly lines, building 
the edges of the fastener.  

 
cg03 WOODEN FASTENER CENTRES. Record all wooden fastener centres on in 

this layer. Choose single point tool and highlight ‘Cen’ (centre) from the Osnap 
tool bar. Using the mouse, place cursor near centre of treenail outline, after it 
has been closed. Rhino will automatically determine the centre. Click left mouse 
button, followed by right mouse button in order to reset the tool.  

 
RECORDING WEAR 
 
cj01 USE WEAR: caused by running ropes or foot traffic (record the extents of this 

damage). 
 
cj02 COMPRESSION MARKS: Compression marks from timbers riding on or 

rubbing against other timbers (i.e. bottoms of floors pressing into keel). Record 
the extents of the feature. 
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RECORDING TOOL MARKS  

Axe Marks: look for stop marks, blade striations and beard. 

Scraper/Planer marks: look for stop marks, blade striations and beard. 

Intentional Lines: boat builder’s marks, often seen along ‘x’ and ‘o’ faces of 
frames (marking joggle locations) and on the inboard and outboard faces of 
planks. See detailed section on intentionally inscribed lines below. 

Saw marks: modern saw marks are often seen around treenails on the 
outboard face of frames and the inboard face of planks. Look for curving 
sweeps or grooves around treenails on the inboard face. 

Record tool marks with Polyline or DigSketch. Use a line with an arrowhead to 
mark tool travel direction or use the leader tool and the FaroArm to make an 
arrow (Dimension>>Leader). Use two parallel lines perpendicu

 
cl01 
 
cl02 
 
cl03 

 
cl04 

 

 
lar to the stop 

mark to denote tool width.  
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RECORDING MISCELLANEOUS FEATURES 
 
cn02 Cross-section: The ‘Surface Paintbrush’ tool (a.k.a. Snit). This layer is used to 

capture (x,y,z) data for the construction of cross sections of the timbers at 
regular intervals. Care should be taken to avoid damaging the surface of the 
timber with the probe tip. Besides cross sections, ‘snit’ is useful for describing a 
surface that is rapidly changing or damaged. It is useful to draw a horizontal 
and vertical DigSketched line over extant treenails, extant wood and metal 
fasteners, concretions and down into voids (and blind treenail holes) within the 
timber.  

 
Planks: Choose DigSketch tool and lightly run the probe tip down the entire 
length of the plank on the inboard and outboard face. Place wetted cotton 
ribbons vertically every 15-30 cm on the face of a plank. Place a pin on the 
upper and lower edges of the plank, stretching the ribbon against the surface of 
the wood. After selecting the DigSketch tool, lightly run the probe tip along the 
centre of the ribbon. Place ribbons as closely as possible on either side of the 
scarf step. After turning the timber over, use the FaroArm to locate the ends of 
the previously drawn cross sections and mark the location with pins. After 
selecting the DigSketch tool and appropriate layer, lightly run the probe tip 
along the centre of the ribbon. 

 
Frames: Repeat the process on four side timbers by placing the cross section 
ribbon at right angles to the timber edges, taking care to place the ribbon 
across the joggled surface on the outboard face of the frames. Where possible, 
the cross section ribbon should be positioned to avoid both treenails and 
rebates.  
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cn04 Text and Symbol: use this layer to annotate drawings and label sample 
numbers and locations. To label a sample location, go to the Dimension 
menu>>Text Block. Select location for label by placing a point on the staple of 
the tyvek sample tag. Enter sample number and press enter. Choose a height 
of 10-20 mm and stay consistent (with both size and font)  After labelling and 
checking the text block number against the tyvek label, remove the tyvek label 
from the timber and discard. Descriptive notes about features seen on the 
timbers should be made on the timber recording sheet and not the drawing 
whenever possible. 

     
 

  
 
  
 

The symbol layer is used to record the orientation and denote the 
inboard/outboard face of the plank or the four sides of a frame. On the inboard 
face of a plank, the symbol is a man, oriented so that his head is facing the 
upper edge of the plank, and his forward (bow facing) arm is raised. Out the 
outboard face of a plank, the symbol is a fish that is ‘swimming’ in the same 
direction as the ship (towards the bow). The fin of the fish is pointing towards 
the upper edge of the plank.  

  
There are four symbols that denote the four sides of a frame. These should be 
drawn approximately 5 cm in diameter, near the centre of the timber face.  

 
 
A NOTE ON THE USE OF ALPHANUMERICAL PREFIXES IN RHINO LAYERING 
Rhino automatically alphabetizes the layer menu. In order to allow the addition or 
deletion of layers, without upsetting the ‘timber face’ order, it is necessary to use 
alphanumerical prefixes that allow for the expansion of the system. This system is 
used as opposed to straight sequential numbering. 
 
*SAVE YOUR WORK EVERY TIME YOU CHANGE LAYERS (Press F5)* 
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USEFUL SUPPLIES TO HAVE ON HAND DURING THE RECORDING PROCESS: 
 
 
Plenty of SS 316 A4 Control Points ~3.5 mm x 20 mm (normal). Sapwood: 50 mm long 
 
Sheet Lead for counterbalancing arm 
 
Capillary Matting for table top padding and keeping timbers wet 
 
Breeze Blocks and Plastisote Foam Sheets 
 
At least 10 outlets/powerpoints on work bench 
 
Lockable Wheels/Casters 
 
Lifting Slings and Shackles 
 
Copper Tacks 
 
Tyvek/Mylar Labels 
 
Pins 
 
Cotton Tape 
 
Nail Angle Rods and longer dendro Probes 
 
Mobile work tables for accommodating unusually shaped timbers 
 
External hard drives and large monitors 
 
Mounting rings on a variety of bases/tripods 
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Rhino3D Icon Functions  
Commonly used for Timber Recording 

 
Open New Rhino File 
 
Open Existing Rhino File 
 
Save Rhino File 
 
Document Properties 
 
Cut 
 
Copy 
 
Paste 
 
Undo 
 
 
Pan 
 
Rotate View 
 
Zoom Dynamic 
 
Zoom Window 
 
Zoom Extents 
 
Zoom Selected 
 
Undo View Change 
 
Four View Ports 
 
Right View 
 
Set C-Plane: Origin 
 
Object Snaps 
 
Select All 
 
Hide Objects 
 
Edit Layers 
 
Object Properties 
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   Text 
 
Select/Cancel 
 
Polyline Tool 
 
Circle Tool 
 
 
Single Point Tool 
 
 
Top View 
 
Bottom View 
 
Left View 
 
Front View 
 
Right View 
 
Back View 
 
Perspective View 

 
Join 
 
Trim 
 
Group (Control+G) 

 
 
Explode 
 
Split 
 
Ungroup (Control+Shift+G) 
 
 
Connect Digitizer 
 
Calibrate Digitizer 
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Edit Layers 
 
Change Object Layer 
 
Set Current Layer 
 
One Layer On 
 
One Layer Off 
 
All Layers On 
 
 

 
 

Object Snap Menu 
 
Snaps to end of line segment 

Snaps to nearest point of line segment (closest to cursor) 

Snaps to single point 

Snaps to midpoint of line segment 

Snaps to centre of an object 

Snaps to intersection (avoid using) 

Snaps to (creates) a point/line perpendicular to selected object 

Snaps to (creates) a line that is tangential to selected object 

Quadrant Object Snap 

Knot Object Snap 

Project Object Snaps 

Disable Object Snaps 

 
 
 
 
 
 
 
 
 
 
 
 
 
 



Hints and Hot Keys:  
 
Use the roller on the mouse to zoom in and out of drawing. 
Use Shift + Arrow keys to scroll along drawing 
Use the View extents button to quickly zoom out. 
 
HOT KEYS 
 
F1 Help Directory   '_Help 
F2 Command History   ! _CommandHistory 
F3 DigSketch    ! _DigSketch 
F4 Properties    !_Properties 
F5 Auto Save    !_Save 
F6 Polyline    !_Polyline 
F7 Grid On/Off  noecho -_DocumentProperties _Grid _ShowGrid _ShowGridAxes ! 
F8 Ortho On/Off    '_Ortho    
F9 Grid Snap On/Off   '_Snap 
F10 Points On    ! _PointsOn 
F11 Points Off    ! _PointsOff 
F12 DigClick    '_DigClick 
 
You can add hot keys by going to the TOOLS Menu, selecting 
Options>Keyboard, and, using the same format, entering in a new command 
macro. 
 
Ten Tips For Effective and Accurate Ship Timber Recording 
 
1. Think Critically, ‘engage the timber’ 
2. Protect Control Points 
3. Be careful with probe tip 
4. Analyze the timber before doing anything (‘Read the wood’) 
5. Be careful with wood, it is one of a kind (also keep it wet) 
6. Save after drawing each layer 
7.  Proof every face and then get someone else to check it 
8. Make back-up of file 
9. Take care of your self. Stretch and rest regularly. 
10.  It is more important to record a feature than not record it based on an inability to 

identify its purpose or proper layer. Use your best judgement and annotate your 
drawing or the timber sheet to show this.   

 
Additional Hints: 
 
Clean timbers as needed prior to recording. They will degrade rapidly after the  
protective mud and concretion has been removed. Conserve pieces with sapwood as  
soon as possible after cleaning and recording. Try to minimise the time between  
cleaning, recording and conservation of these fragile pieces. 
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Timber Function Codes for the Newport Medieval Ship 
 
 
Function Code Description 
 
Beam   Beam 
 
BB   Bilge board 
 
BRP#   Brace (chock) to keelson port side 
 
BRS#   Brace (chock) to keelson starboard side 
 
CP#.#   Port ceiling plank 
 
CS#.#   Starboard ceiling plank 
 
F#.#   Framing timber: F#.0 = Floor timber 

F#.[odd number] =  framing timber port side 
F#.[even number] = framing timber starboard side 
 

Filler   Filler Board 
 
Head   Barrel/Cask Head 
 
Hoop   Barrel/Cask Hoop 
 
Keel   Keel 
 
Knee   Knee 
 
P#.#   Port side hull plank 
 
R#   Rider 
 
S#.#   Starboard side hull plank 
 
Son   Keelson 
 
Stave   Barrel/Cask Stave 
 
Stem   Stem Post 
 
STRP#.#  Stringer port 
 
STRS#.#  Stringer starboard 
 
Tingle   Tingle/patch timber 
 
Notes: #= number    ?=uncertain of accuracy of function code 
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APPENDIX 1 
 

Hints From Dr. Fred Hocker (From Hocker, Fred, Faro Manual, 2003, Version 2). 
 
9.3 Problem planks  
In the case of non-rigid timbers (long planks, usually), the problem of leapfrogging is 
complicated by the difficulty of getting the plank to assume the same shape after 
turning. In Cam2Measure it is sometimes possible, through trial and error and use of 
the individual point residuals, to gradually adjust the plank until it matches up, but the 
process can be very frustrating, as the residuals indicate the magnitude of the error, 
but not the direction.  Our experience is that if the original shape cannot be re-
established after 30 minutes fiddling around, it is unlikely to be re-acquired and it is 
best to proceed to alternative 2, recording the second side as a series of short 
segments.  Because only three points can be used for calibrating in Rhino, it is not 
possible to record the second side of a non-rigid timber except as a series of 
segments.  This method works on the assumption that while the residuals for the 
whole plank may be unacceptably large (although we are still talking in millimetres), 
the amount of changed curvature in any short piece of the plank is negligible.  By 
recording the second side as a series of short segments, each segment can be 
aligned to the first side and to the preceding and following segments with acceptable 
accuracy.  It requires forethought, in that there must be enough control points to allow 
all parts of the plank to be aligned separately.   We have found that setting control 
points at 50 cm intervals along both edges of a plank is sufficient.  It sometimes turns 
out that the problem in the plank is local, rather than global, and so it is not necessary 
to break it up into 50-cm segments.  Instead, the plank can be broken down into a few 
larger segments, or one large segment and several short ones.   
 
9.3.2 Problem planks in Rhino 
Start at one end of the plank and choose three control points defining the limits of an 
area you feel to be acceptably rigid.  Use these points to CALIBRATE, and then record 
the area they define using DigSketch, Polyline, etc.  Once finished, move down the 
plank and choose another three points.  At least one, and preferably two of the points 
used should be the same as in the previous alignment.  Proceed in this way until 
finished.  Although it seems cumbersome, the ability to record directly onto a layer 
streamlines this more than enough to compensate. 
 
Filling small gaps in lines that should be continuous 
This can be done in two different ways.  If the gap is very small, and both features are 
on the same layer, simply select both of them, and then click on the JOIN tool.  A 
dialogue box will then inform you that there is a gap between the two objects (and tell 
you the size of the gap), and ask if you want to join them.  If you click YES, then a 
short segment will be drawn between the ends of the two lines.  No new data points 
will be added. 
 
If the features are on different layers (such as Edges Original and Edges Damaged, a 
common combination), then you will have to fill the gap by drawing a short segment 
using the POLYLINE command.  Set Object Snap to END, and click on the two ends 
of the gap in succession.  Choose which layer you want the gap-filling segment to be 
on either by selecting that layer as the active layer, or move the segment to the 
appropriate layer afterwards. 
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APPENDIX 2 
 

How to Print out a Two-Sided Ship Timber Drawing 
 
 
1 After a two-sided timber has been recorded and initially checked, you must 

make a printout of it. This task can be performed from the computers on the 
recording tables. Open appropriate finished Rhino (.3dm) file.  
(i.e. 598 S3_4). Save file to the desktop as ‘598 printout.’  

 
 
2 Make sure ‘Ortho’ is selected. Go to Edit Layers and turn off the entire 

outboard face (layers eb01 through gn05). Select remaining layers (control-A) 
and then press Group Objects (control-G). Using mouse cursor, move plank 
towards the top of the screen until it is completely clear of its original location.  

 
 

3 Press ‘All Layers On’ icon. Go to Edit>Select Objects>Invert and press control-
G (Group Objects). Click on Right View icon. 

 
 
4 Go to Transform>Rotate. For the centre of rotation, click mouse once just to the 

left of the outboard plank face and then once just to the right. Move cursor to 
the left until the plank has rotated 180 degrees. Click left mouse button once.  

 
 
5 Return to Top view. It may be necessary to drag the outboard face upwards so 

that it is near, but not touching the inboard face.  
 
 
6 Using the Edit layer menu, turn off the following layers: Measuring Tape, 

Control Points, Inboard and Outboard Nail Angles, Inboard and Outboard 
Wooden Fastener Centres, and Inboard and Outboard Text/Symbols. Using the 
label layer, add an appropriate polyline as a scale bar (typically 1 metre) and 
label. 

 
7 Ensure no objects are highlighted in yellow. Go to File>Print. Choose Printer: 

DeskJet 1220C. Click on Properties and select Landscape and press OK. 
Select Extents, Print in Color, Scaled to Fit and Center Objects on page. 
Preview Print Job and Press Print. Review printout for accuracy. 

 
 
8 Take printout and place behind appropriate timber recording sheet on the 

clipboard of two-sided timbers/planks to be checked (in cow tag order).  
 
9 Under no circumstances should you save your changes to the original 

source file. Delete the ‘### printout’ file immediately after the printout is 
complete. You can also create a read-only version of the original file. 
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APPENDIX 3 
 

How to Print out a Four-Sided Ship Timber Drawing 
 
 
1 After a four-sided timber has been recorded and initially checked, you need to 

make a printout of it. This task can be performed from the computers on the 
recording tables. Open appropriate finished Rhino (.3dm) file(i.e. 1134 F28_0). 
Save file (Save as) to the ‘Frame Print Outs’ in the Recorded Timbers>>Frames 
folder as ‘1134 printout.’ Don’t delete these printout files, as they are useful to 
refer to during the checking procedure.  Under no circumstances should you 
save your changes to the original source file. 

 
 
2 Rotate frame in the Top view until it is as level as possible. Make sure ‘Ortho’ is 

selected for all of the following directions.  
 
 
3  Go to Edit Layers (layer cake) and turn off everything except for the X 

(Forward) face and label layers. Select remaining layers (control-A) and then 
press Group Objects (control-G). Using mouse cursor, move frame towards the 
top of the screen until it is well clear of its original location. 

 
 

4 Go to Edit Layers and turn on the O (Aft) face layers. Select these layers and 
press control-G (Group Objects). Click on Right View icon.  

 
 
5 Go to Transform>Rotate. For the centre of rotation, click mouse once just 

above the O face and then once just to the side. Move cursor to the left or right 
until the plank has rotated 180 degrees. Click left mouse button once.  

 
 
6 Return to Top view. It may be necessary to drag the O face upwards so that it is 

below, but not touching, the X face.  
 
 
7 Turn on the Inboard layers. Select and Group. Click on Right View icon. Select 

Inboard face and go to Transform>Rotate. For the centre of rotation, click 
mouse once just above the Inboard face and then once just to the right or left. 
Move cursor to the left until the frame has rotated 90 degrees anti-clockwise. 
Click left mouse button once.  

 
8 Return to Top view. Turn on the Outboard layers. Select and Group. Click on 

Right View icon. Select Outboard face and go to Transform>Rotate. For the 
centre of rotation, click mouse once just above the Outboard face and then 
once just to the right or left. Move cursor to the right until the frame has rotated 
90 degrees clockwise. Click left mouse button once. 
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9 Using the Edit Layers menu, turn off the following layers on each face: 
Measuring Tape, Control Points, Nail Angles, Wooden Fastener Centres, and 
Text/Symbols. 

 
 
10 The four faces should be evenly spaced and arranged in the following order: 
 
 Forward 
 Aft 
 Inboard 
 Outboard 
 
 Label each face, using the text tool, label layer, and 100 mm text, and place 

text field beneath the lower left edge of each face. See example on following 
page. Using the label layer, add an appropriate polyline as a scale bar (typically 
1 metre) and label. 

 
 
11 Ensure no objects are highlighted in yellow. Go to File>Print. Choose Printer: 

DeskJet 1220C. Click on Properties and select Landscape and press OK. 
Select Extents, Print in Colour, Scaled to Fit and Centre Objects on page. 
Preview Print Job and Press Print. Review printout for accuracy. 

 
 
12 Take printout and place behind appropriate timber recording sheet on the 

clipboard of four-sided timbers to be checked (in cow tag order).  
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Example of timber orientation of a recorded four-sided ship timber. 
 
 
 



APPENDIX 4 
 

TYPES OF INSCRIBED LINES 
TYPE 1 
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TYPE 2 
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TYPE 3 
 
 
 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

 
 
 
 
 
 
TYPE 4 
 



 
MORE TYPES: FEATURES IDENTIFIED DURING RECORDING 
 

 

 

-DIAMONDS  

 

 
 
 
 
 

 
TYPE 1: WIDELY CONVERGING SCRIBED LINES 
 
 
 
 
 
 
 
 
 

 
TYPE 2: 2MM WIDE SCRIBED LINES 
 
 
 
 
 
 
 

 
TYPE 3: DIAMONDS AND HALF

    AT ENDS OF CRACKS 
 
 
 
 
 
 

 
 

TYPE 4: INSCRIBED LINES AT JOGGLES ON 
FRAMES 
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TYPE 6: INSCRIBED LINES ASSOCIATED  
 WITH STEP ON LAND FOR SCARF ON ADJACENT OR 
NEARBY STRAKE 
 
 
 
 
 
 
 

 
 

 
 
 
TYPE 8: SHALLOW RECTANGULAR HOLE 
 
 
 
 

 
 

 

 
 
TYPE 5: CLAMP MARKS 
 
 
 
 
 

 
 
TYPE 7: NAILHEAD STAR IMPRESSIONS 
 
 
 
 
 
 
 
 
 

 



APPENDIX 5 
 

Digital Recording of Four-Sided Ship Timbers using a 
FaroArm 3D Digitizer and Rhino software 

 
*Supplement to the Timber Recording Manual* 

 
The following document is designed to guide the FaroArm user through the correct 
way to record a four-sided ship timber. While similarities exist between the recording 
of two-sided timbers (i.e. planks and ceiling) and four-sided timbers (i.e. floors and 
frames), there are some important differences which are detailed below. As always, 
the timber recorder should endeavour to accurately capture all of the relevant details 
during the creation of the primary record, while remaining mindful of future intentions 
regarding the use of this record. Attention to detail is paramount. This addendum is 
meant to serve as a specific and detailed supplement to the Timber Recording Manual 
and the ‘Faro Manual v.2’, by Dr. Fred Hocker. Please refer to these documents for 
detailed information and procedures concerning calibration, digitizer alignment, layer 
management, and control point installation.  
 
Handling Four-Sided Timbers: 
 
Waterlogged floors and frames can be heavy, awkward and structurally weak, and 
require special handling. It is often necessary to use the overhead gantry with 
appropriate slings and padding. When lifting, areas of sapwood should be avoided 
when possible, with broad pieces of plastisote and plywood spreaders employed to 
reduce point loading. Areas of sapwood can be damaged by the movement of the 
plastisote or slings during lifting. Ensure that the slings and padding remain taut during 
the entire lifting process. When lifting, use appropriate safety gear, including steel toe 
caps and hard hats. Have a lifting plan. Avoid leaving timbers suspended for 
prolonged periods of time. Damaged timbers can have hidden cracks that may widen 
during the lifting process. If these are noticed, lower the timber into the water or onto a 
table as quickly as possible. Damaged timbers can be placed on ‘stretchers’ which can 
be lifted without placing any stress on the timbers. Areas of timbers wrapped with 
orange or red netlon require careful inspection and handling. Slings that are 
continuously kept wet should have 10% of the working load limit subtracted from the 
working load limit. Slings will last longer if they are kept continuously wet or 
continuously dry. Have slings professionally inspected every 6-12 months. 
 
Once timbers have been placed on the recording table, concrete blocks can be placed 
near the inboard/outboard face, with foam wedges inserted in the gap to prevent the 
timber from moving. It is easier to record the timber with the lifting slings and pads 
removed, but this is not always possible. However, two people can usually lift one end 
of a timber while a third carefully removes the sling and plastisote pad. Three people 
are again required to reinsert the sling and padding when the timber is ready to be 
lifted again. Alternatively, a bed of plastisote can be placed on the table, leaving a gap 
for the lifting slings, although more problems with timber movement may be 
encountered. Use G-Clamps to bend foam underneath the front edge of the recording 
table. 
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The sapwood on frames can dry out quickly. Keep timber ‘hydrated’ by spraying 
periodically with spray bottles filled with clean tap water. Cover the timber with wetted 
capillary matting when not actively recording.  
 
Recording Four-Sided Timbers 
 
When recording frames, begin with the forward face facing up, and the inboard face of 
the timber facing towards the back edge of the table. For floor timbers, position the 
timber so that the rebate for the limber hole is placed near the front edge of the table. 
For side frames, position the timber lengthwise along the table, so that the maximum 
amount of two faces can be reached by the FaroArm, without moving the timber or the 
FaroArm. It is generally easier to move the timber than the FaroArm. It may be 
necessary to position one of the additional tables (2 x 1 metres) to accommodate 
timbers that are unusually long or curved (i.e. v-shaped floors).  For some timbers, it 
may be necessary to temporarily remove the pulley counterbalance cable on the 
recording table before lowering the timber with the gantry.  
 
Four-sided timbers are usually recorded two faces at a time (typically the 
forward/outboard faces followed by the after/inboard faces). The timber is then moved 
so as to reach the remainder of the first two faces, or rotated 180 degrees along the 
lengthwise axis to record the remaining faces. It is often easier to return the timber to a 
storage tank and rotate it in the water and lift it back on to the table in the required 
orientation, than to handle it in the air.  In certain circumstances, the FaroArm can be 
carefully moved to another location on the recording table or tripod. It is necessary to 
carefully reroute the cables and recalibrate the probe tip whenever the FaroArm is 
moved. 
 
As a general rule, nearly all of the frames were labelled on the forward face during the 
excavation. The cow tag should also have been attached to the forward face. 
However, it is important to critically examine each timber prior to recording, ensuring 
that the assumed orientation is correct. The majority of side frames are scarfed over 
the floors, with the 2nd futtocks generally scarfed over the first futtocks, although there 
are exceptions. Consult the schematic framing diagram to help determine the correct 
orientation of a frame. 
 
Installation of Control Points: A minimum of three control points are necessary to 
accurately orient the FaroArm probe tip to the timber. Using the electric drill, insert 
stainless steel control points (Cross headed wood screws) along the inboard and 
outboard faces at an interval not to exceed 50 cm.  Avoid placing control points in 
cracks. Disarticulated pieces require additional control points (a minimum of three), 
while areas of sapwood should be avoided (although longer screws may be placed in 
these areas if necessary). When placing control points on the outboard joggled face, it 
is good practice to insert the points well away from rebates, treenails and cracks.  
 
Turn on computer, FaroArm, and monitor. Arrange wireless keyboard and mouse, 
connect if necessary. Open four-sided timber recording template (Rhino 3dm file) from 
templates folder on the desktop. Save file in the Recorded Timbers>>Frames folder as 
a 3-4 digit cow tag number followed by the function code. Example: ‘945 F33_0’ can 
be found in the Recorded Timbers\Frames\Frame 33. 
Recording features unique to four-sided timbers: 
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When recording a four-sided timber using a FaroArm, you are effectively creating a 
digital record that is an accurate three-dimensional model of the timber. This captured 
data can also be displayed as a set of four independent traditional two-dimensional 
drawings. It is important to keep this in mind when recording four-sided timbers. On 
each face, you must draw everything you can see from a plan view. You will end up 
duplicating lines along the edges of timbers (i.e. an original edge on the after inboard 
face with also show up as an original edge on the upper after face). It is necessary to 
duplicate these lines in order for the two-dimensional drawings to be valid and make 
sense. It can be easier to record the forward edge of the inboard face of a timber while 
it is in the X/out position, but you have to keep careful track of the layers. It is also 
possible to copy and paste the same edges, and subsequently change the layers, but 
you must carefully manage and proof the different layers. 
 
When drawing original edges on the outboard face joggles, use DigiSketch to outline 
each rebate and then use several lines to denote the base of the rebate and connect 
these to the top of the rebate. The rebates should be drawn in the original edges layer. 
This is sufficient detail for recording what were hastily carved features. See diagram 
and photograph below: 
 

stringers and into the inboard face of the frames. Examine the treenails for wedges, 
dimples or other interesting features. Also include any associated rebates. When 
recording an empty blind treenail hole, use a long probe tip to capture the depth and 
shape of the hole using the appropriate cross-section layer. Look for square treenails 
and square chiselled treenail holes in areas where braces were attached to the 
inboard face of the floors. Some floors may have chisel marks where part of the frame 
was cut away to accommodate a pump hole or other feature. Record these using the 

 
 
All nails on four-sided timbers should be 
additional nails to be driven into or ar
associated rebates are occasionally seen 
The ceiling planking was also often nailed dire
Record any rebates as originals e
Attempt to get a valid nail de
on the timber recording sheet. 
 
Treenails are often seen on the inboard fa
outboard of the hull, through 

drawn on as additional nails. Look for 
ound rebates on the outboard face. Nails with 

on the inboard face, often around scarves. 
ctly to the inboard face of the frames. 

dges. Nail holes are often filled with concretion. 
pth and angle. If not possible, make a note to that effect 

ce. These can either be driven from 
the planking and frames, or from the inboard, through 



planer/scraper layer for the time being and make a note on the timber sheet that chisel 
marks are evident.  
 
Cross-Sections: On four side timbers place the cross-section ribbon at right angles to 
the timber edges, taking care to place the ribbon across the joggled surface on the 
outboard face of the frames. Where possible, the cross-section ribbon should be 
positioned to avoid both treenails and rebates.  Place one cross-section on each 
joggle and every 20-30 cm along a scarf. Place cross-sections over extant treenails, 
on both the inboard and outboard face.  
 
Four-sided Timber Symbols: There are four symbols that denote the four sides of a 
frame. These should be drawn approximately 5 cm in diameter, near the centre of the 
timber face.  Label your drawing in the top view (X=Forward Face) in the lower right 
hand corner near the timber. 
 
X = Forward face 
0 = Aft Face 
∆ = Outboard Face 
X  = Inboard Face 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

*SAVE YOUR WORK EVERY TIME YOU CHANGE LAYERS (Press F5)* 
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APPENDIX 6 
 

WHAT TO LOOK FOR WHEN CHECKING A DIGITALLY 
RECORDED TIMBER 

 
*Supplement to the Timber Recording Manual* 

 
After recording a timber, it is important to have someone else proof it. 
First scrutinise the digital drawing, and then examine the timber. You are checking for 
missed features, correct layering, and consistency. If a feature such as a fastener 
typically appears on two faces, and is drawn on only one face, it warrants further 
investigation. Begin by examining the Rhino 3dm file of a timber in the top view, with 
all layers switched on.  Make sure the cow tag number agrees with file name, the label 
in drawing, and timber recording sheet. Ensure cow tag, function code, name and date 
are correct and on the correct layer and cross reference to the database. Chase any 
inconsistencies. 
 
While scrolling along the length of the timber, check for the following: 
 
Clinker nail should show up on the inboard and outboard faces and should have either 
a head or rove (except on scarves). Centres should come in pairs. Roves are 
generally evenly spaced along the inboard face. Inverted clinker nailing patterns are 
often seen in the bow and stern. Look for patterns and gaps in the placement of 
fasteners.   
 
All nails should have a nail angle when they do not pass through the timber. Small 
additional nails often pass through the timber. They can be concreted and 
consequently well hidden. Investigate every blind additional nail carefully. Closely 
examine each and every scarf for additional nails. Look along edges of planks for 
additional nails driven in as repairs.  
 
Every treenail should show up on the inboard and outboard faces with centres. Cross 
sections should be drawn over each extant wooden fastener. Wooden fasteners are 
typically seen on both inboard and outboard faces.  
 
Check that at least two lines of grain have been drawn on each face, and spot check 
for accuracy and correct layer selection.  
 
Edges should always terminate into other edges or features. They shouldn’t just 
end in space. Rotate the timber, using the down arrow (press 5-10 times), and 
scroll along the length, checking fastener centres and looking for loose lines 
(naked edges). All edges (black and gray lines) should terminate into other 
edges or fasteners. Sapwood should be drawn as a continuous loop (i.e. you 
should be able to trace the extents of the sapwood around the different faces of 
the timber. 
 
Turn on Cross sections only and rotate the drawing. The wire frame should accurately 
represent the timber on the table. With all layers on, freely rotate the timber and ask 
yourself, is this a reasonable and accurate model of this timber? All extant fasteners 
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and concretions (wood and metal) should have cross sections drawn on. Check to see 
if cross sections are connected along the edges of the timber.   
 
Zoom out from the drawing and look for flyers (lines and points drawn away from the 
timber). Delete as appropriate. 
 
Check for accuracy of inscribed lines. Look for Type 3 inscribed lines at the ends of all 
splits on the inboard and outboard faces. Check if inscribed lines continue under 
roves, nail heads, or frames.   
 
Check face symbols (Star, triangle, circle, x, empty box, x-box, fish, man) for correct 
layering and orientation. 
 
On flexible planks, or where leap-frogging (use of closely spaced control points) was 
necessary, manually check the thicknesses on the tables of the scarves and compare 
them to drawing. 
 
These may be the rules, but there are always exceptions…think critically about the 
justifications you are using to ‘break’ the rules. Above all, please be consistent. Your 
job as checker is to find any faults or inconsistencies. Mark any faults with a long poly 
line in the blue label layer. When in doubt, mark it up. Overwrite the existing file. 
 
Initial a drawing that you have check with your name and the date. This way the 
person making the corrections can ask for further clarification. 
 
It is the responsibility of the recorder to make the necessary changes.  
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APPENDIX 7 
 

Notes on Recording Braces 
 
Braces or chocks were used to laterally stabilize the mast step/keelson feature. There 
are 20 of these timbers, 10 on the port and 10 on the starboard. They rest on top of 
the floor timbers, running in a parallel orientation with the frames, and are affixed with 
treenails. These treenails often have a squared shaft, and are driven into a round hole. 
Record both the round treenail hole and the square treenail under the same layer. 
Please don’t remove these treenails, as they are relatively rare and may warrant 
further study. Record the brace up on breeze blocks if necessary. Because these 
timbers have relatively flat faces, they can conveniently be recorded one face at a 
time, if the control points are properly placed (i.e. one on every face, except for the 
bottom).  
 
 
Orientation of these timbers is as follows: The cow tags are usually (but not always) on 
the inboard face. The braces have flat outboard faces. Begin with this face resting on 
the table. Now imagine you are standing at the stern of the vessel, looking forward. 
The starboard braces will be to the right of the keelson, and the port to the left. The 
bevelled inboard face will be facing up, and resemble a wedge in profile. The pointed 
end will be facing away from the keelson, while the thick end will be butted up against 
the mast step/keelson (i.e. facing the centreline of the vessel).  
 
 
Begin recording by using the four-sided template. Save the file as BR(P or S…Port or 
Starboard)(#1-10) (i.e. BRS8) in the Braces folder under Recorded Timbers. Most of 
the braces are in good condition, so most of the edges will be recorded as original 
edges. Also watch out for sapwood. Treat the layering the same as you would a frame. 
The forward face of the brace is the X face, while the after face is the O face. The only 
things that need to be recorded on the ends are grain and sapwood. Don’t worry about 
drawing lengthwise snit either. Remember to add the four-sided timber symbols as 
well.  
 
If you would like to look at a completed digital drawing, open BRS8 in the Recorded 
Timbers>Braces folder.  
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APPENDIX 8 
 

Digital Recording of Ceiling and Stringers using a  
FaroArm 3D Digitizer and Rhino software 

 
*Supplement to the Timber Recording Manual* 

 
The following document is designed to guide the FaroArm user through the best 
practice of recording ceiling planking and stringers. While similarities exist between the 
recording of two-sided timbers (i.e. planks and ceiling) and four-sided timbers (i.e. 
floors, frames and stringers), there are some specific attributes which are detailed 
below. As always, the timber recorder should endeavour to accurately capture all of 
the relevant details during the creation of the primary record, while remaining mindful 
of future intentions regarding the use of this record. Attention to detail is paramount. 
This addendum is meant to serve as a specific and detailed supplement to the Timber 
Recording Manual and the ‘Faro Manual v.2’, by Dr. Fred Hocker. Please refer to 
these documents for detailed information and procedures concerning calibration, 
digitizer alignment, layer management, and control point installation.  
 
Handling Ceiling and Stringers: 
 
Waterlogged ceiling and stringers can be structurally weak, and therefore require 
special handling. It is often necessary to use the overhead gantry with appropriate 
slings and padding. When lifting, areas of sapwood should be avoided, with broad 
pieces of plastisote and plywood spreaders employed to reduce point loading. Use 
plywood spreaders that are wider than the stringer and sling the load with a 2-3 metre 
endless sling shaped like a ‘U’ (i.e. not choked).  Areas of sapwood can be damaged 
by the movement of the plastisote or slings during lifting. To avoid this, ensure that the 
slings and padding remain taut during the entire lifting process. Stingers should be 
lifted with the inboard face facing upwards. They should be kept in this orientation 
when transferring to and from the storage tanks and the cleaning and recording tables. 
Stringers and ceiling that are extensively damaged or weak should be lifted onto a 
stretcher or scaffold board that has been submerged and weighted down with 
sandbags, and then the whole cradle arrangement and stringer slung up and lifted. 
Avoid lifting points near the extremities of the timbers (i.e. balance the load). Many of 
the stringers were long (up to 12 metres) and were cut to facilitate lifting on site. In 
some cases these timbers have been further subdivided to aid handling and recording. 
   
Orienting and Recording Ceiling Planking: 
 
Orient ceiling planking like hull planking, using the 2-sided timber template. Ceiling 
was originally labelled on the inboard face, towards the forward end. The orientation of 
ceiling has been determined with reference to the site plans and photogrammetry. 
Check the timber for a recently placed Tyvek label held by a large headed map pin 
indicating the forward/aft end of the timber. This label should be removed after 
recording the timber. Look out for and record saw marks, cut branches, and knots, as 
well as end grain, where possible. Carefully examine the ceiling for small additional 
nails. 
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Orienting and Recording Stringers: 
 
Select the Stringer Template.  
 
Save the file in the Ship Data/Recorded Timbers/Stringers folder, in the appropriate 
stringer run. The two new faces are upper and lower, which take the place of Forward 
and Aft. There are new symbols for these faces, which are described below. 
 
When recording stringers, begin with the inboard face facing up, and the lower 
side/face of the timber facing towards the front edge of the table. With the inboard face 
facing up, the forward edge of port stringers should face towards the right, and the 
forward edge of starboard stringers should face towards the left. Consider the keelson 
the centreline of the vessel, with all lower sides/faces oriented towards it. The 
orientation of stringers has been determined with reference to the site plans and 
photogrammetry. Check the timber for a recently placed Tyvek label held by a large 
headed map pin indicating the forward/aft end of the timber. This label should be 
removed after recording the timber. 
 
Four-sided timbers are usually recorded two faces at a time (typically the Inboard and 
Lower faces followed by the Outboard and Upper faces). The timber is then moved so 
as to reach the remainder of the first two faces, or rotated 180 degrees along the 
lengthwise axis to record the remaining faces. It is often easier to return the timber to a 
storage tank and rotate it in the water and lift it back on to the table in the required 
orientation, than to handle it in the air.  In certain circumstances, the FaroArm can be 
carefully moved to another location on the recording table or tripod. It is necessary to 
carefully reroute the cables and recalibrate the probe tip whenever the FaroArm is 
moved.  
 
Installation of Control Points: Inserted every 20-30 cm along upper and lower faces. 
Use long screws in areas of sapwood. 
 
When recording a stringer using a FaroArm, you are effectively creating a digital 
record that is an accurate three-dimensional model of the timber. This captured data 
can also be displayed as a set of four independent traditional two-dimensional 
drawings. It is important to keep this in mind when recording four-sided timbers. On 
each face, you must draw everything you can see from a plan view. You will end up 
duplicating lines along the edges of timbers. It is necessary to duplicate these lines in 
order for the two-dimensional drawings to be valid and make sense.  Draw all rebates 
using the original edges layer. All modern sawn edges should be recorded as limits of 
original edge. 
 
All nails on four-sided timbers should be drawn on as additional nails. Nail holes are 
often filled with concretion. Attempt to get a valid nail depth and angle. If not possible, 
make a note to that effect on the timber recording sheet. 
 
Draw end grain where visible, especially on edges of rebates and across modern cuts. 
Use the inboard grain layer and inboard sapwood layer to record grain and sapwood 
seen on the ‘5th and ‘6th’ faces (the ends) of the timber.  
 
Examine treenails for wedges (these are often rectangular and are commonly seen on 
the inboard face), dimples or other interesting features. Also include any associated 
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rebates. When recording an empty blind treenail hole, use a long probe tip to capture 
the depth and shape of the hole using the appropriate cross-section layer. Treenails 
often occur in pairs that are 10-20 cm apart, running down into the frame.  
 
Cross-Sections: On four side timbers place the cross-section ribbon at right angles to 
the timber edges. Where possible, the cross-section ribbon should be positioned to 
avoid treenails.  Place one cross-section on each rebate and every 15-20 cm in other 
areas. Place cross-sections over extant treenails, on both the inboard and outboard 
face. If the area around the treenail is rebated, use the same cross section lines to 
encompass the treenail and rebate. 
 
Look out for tool marks, especially saw marks, as well as inscribed lines.  
 
Four-sided Timber Symbols: There are four symbols that denote the four sides of a 
stringer. These should be drawn approximately 5 cm in diameter, near the centre of 
the timber face. The square symbols can be quickly made by using the corner to 
corner rectangle tool. It is found under the curve menu>>Rectangle>Corner to Corner. 
Place the first point with the FaroArm, and type in 50 mm for each side. Use polylines 
to connect across the corners.  

 
  
 
Lower Side/Face 
 
 
 
Upper Side/Face 
 
 
Outboard Side/Face 
 
 
Inboard Side/Face 
 
 
 

 
Finally, label your drawing in the top view (Inboard face) in the lower right hand corner 
near the timber.  
 
A note of caution: The layers and sides of the template layer menu are in a 
different order now, and some have been deleted. Familiarize yourself with the 
new stringer template layering system prior to recording.   
 
 
 

 
 



APPENDIX 9 
 

Capturing Metrical Data from RHINO Files 
 

*Supplement to the Timber Recording Manual* 
 

The following guidelines are for complete undamaged hull planks. On damaged 
planks, capture as much data as possible, and type the letters 'na' into any field where 
you cannot obtain the necessary measurement. There are fields available to describe 
the condition of the plank (i.e. damaged or incomplete). All measurements should be 
rounded to the nearest millimetre. Always move forward to aft when recording nail and 
treenail spacing sequences and thicknesses. 
In the plank status field, enter complete if a majority of the edges are extant, partial if a 
majority of the plank is intact, but substantial edges are missing, and enter fragment if 
a minority of the plank is intact. If a measurement is problematic (due to excessive 
damage or distortion), it may be better to ignore it and move on. 
 

 
Open Template (Plank Data Acquisition excel file) Go to File » Save As» FUNCTION 
CODE (i.e. P9_5). Save file in Ship Data\Data Acquisition\Metrical Data\Planks\P9. 
Double left click on worksheet tab (bottom left hand of screen) and rename to 
appropriate function code. Open appropriate Rhino file (i.e. plank P9_5) and enter 
identification data in Excel Spreadsheet. In certain cases, there will be two or more 
timbers with the same function code. If a timber with a single function code is 
fragmented, search for a composite file and take measurements from this file. Do not 
modify the worksheet, as it may impede future analytical approaches, such as drilling 
down through the work sheets. There should be one metrical data Excel file for each 
complete timber. When finished, fill in metrical data field in database with the date. 
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 Figure 1. Inboard face of port side plank. 
 
 
Turn off outboard layers. View timber in the top view. On the Object Snap toolbar, turn 
off ortho and planar. Select Label layer as the layer in current use.  
Using the analyze » distance command, measure the overall length of the plank (in a 
straight line at the area of maximum length) and enter in the appropriate field on the 
Excel sheet. Measure width at the following three general locations: immediately aft of 
the forward scarf, in the centre of the plank, and immediately forward of the aft scarf.  
 
Measure the width of the aft scarf near the centre of the table. Use as straight a line as 
possible. You can use ortho, but make sure the text box associated with the crosshair 
cursor in Rhino does not say 'INT.' (Figures 2).  
 
 

 
Figure 2. Aft scarf inboard table width. 
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Land Gradient (Figure 3) 
Near the centre of the plank, turn on ortho and run a polyline from the lower inboard 
edge towards the upper inboard edge of the plank. Where this line crosses the land 
(as seen in the plan view), run an ortho polyline from the land down to join it. In the 
front view, measure the length of this vertical line. This is the land height. Using the 
first polyline, measure the distance from the lower inboard edge of the plank to the 
point where this line intersects the land height. This is the width of the land. These 
measurements will be used to automatically determine the gradient of the land. 
Reverse procedure for measuring the land on the outboard face. 
 

 
Figure 3. Determining the inboard land gradient. 
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Aft Scarf Gradient (Figure 4) 
On an aft scarf, in the top view, run an ortho polyline from the centre of the aft inboard 
edge forward past the scarf. Where this line crosses the lower edge of the scarf joint, 
run a vertical ortho polyline down to join it, from the lower edge of the lip. In the front 
view, measure the length of the vertical line. This is the scarf table height. Measure the 
distance from the aft inboard edge to the point where the vertical line intersects it. This 
is the length of the scarf table. These measurements will be used to determine the 
gradient of the scarf.  
 

 
Figure 4. Determining the gradient of the aft scarf. 
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Lip Gradient (Figure 5) 
On an aft scarf, in the top view, run an ortho polyline from the centre of the lower lip 
forward past the upper lip. Where this line crosses the upper edge of the scarf lip, run 
a vertical ortho polyline down to join it. In the front view, measure the length of the 
vertical line. This is the lip height. Measure the distance from the lower lip forward to 
where the vertical line intersects it. This is the length of the lip. These measurements 
will be used to determine the gradient of the lip.  
 
 

 
Figure 5. Determining the aft scarf lip gradient. 
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Distances between features and fasteners: 
Treenail Spacing: Snap a distance between centres on adjacent treenails. Measure 
between the treenails that have centres, skipping those without. (Figure 6).  
 

 
Figure 6. Measuring distances between treenail centres. 
 
Treenail Diameter: Measure diameter of treenail or treenail hole. When measuring the 
fastener, it doesn't matter where you start, as long as you cross the centre during the 
measurement (Figure 7).  
 

 
Figure 7. Capturing metrical data from the treenails 
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Clinker Nail Spacing: Measure distance between centres on confirmed clinker nails 
(i.e. on nails with a rove visible. Do this on the upper inboard edge only. Do not 
record the distances between the roves in the centre of the scarf. Do not 
record/include the distances between the clinker nails in the centre of the scarf. 
 
Clinker nail shaft width: Measure width (the Newport ship clinker nails tend to be 
square shanked).  Measure approximately three nail shafts per metre of plank length.  
 
Roves: Measure two dimensions for each rove. Enter the larger dimension first, 
followed by the smaller dimension (Figure 8). Measure approximately three roves per 
metre of plank length. 
 

 
Figure 8. Capturing metrical data from the clinker nails and roves. 
 
Wood Spike nails: Measure the maximum width (the Newport Ship wooden spike nails 
tend to be square shanked). Note location: forward scarf, aft scarf, inboard land, 
outboard land, and body or edge of plank. With inboard and outboard layer on, 
measure the maximum length. 
 
Large and Small Additional Nails: Measure width (shanks tend to be squared), and 
diameter of head if present. Note location: forward scarf (FS), aft scarf (AS), inboard 
land (IL), outboard land (OL), inboard body of plank (IBP), outboard body of plank 
(OBP) or upper edge of plank (UEP), or lower edge of plank (LEP). 
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OUTBOARD 
 
Turn on outboard layer only 
 
Measure the width of the forward scarf table width (Figure 9). 
 

 
Figure 9. Forward scarf outboard table width. 
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Forward Scarf Gradient (Figure 10) 
On a forward scarf, in the bottom view, run an ortho polyline from the centre of the 
forward outboard edge aft just past the scarf. Where this line crosses the edge of the 
scarf (in the bottom view), run a vertical ortho polyline down to join it. In the front view, 
measure the length of the vertical line. This is the scarf height. Measure the distance 
from the forward outboard edge aft to the point where the vertical line intersects it. 
This is the length of the scarf joint. These measurements will be used to determine the 
gradient of the scarf.  
 

 
Figure 10. Determining the forward scarf gradient. 
 
Clinker Nail heads: Measure the maximum diameter of approximately three clinker nail 
heads per metre of plank length along the lower outboard land only. 
 
Frame Nails: Measure the width (the Newport Ship frame nails tend to be square 
shanked) and nail head diameter. 
 
Additional Nails: Measure width (shanks tend to be squared), and width of head if 
present. Note location: forward scarf (FS), aft scarf (AS), inboard land (IL), outboard 
land (OL), inboard body of plank (IBP), outboard body of plank (OBP) or upper edge of 
plank (UEP), or lower edge of plank (LEP).  
 
Treenail heads: If present, record maximum and minimum diameter (Figure 7).  
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INBOARD AND OUTBOARD 
 
Turn both faces on to capture thicknesses. Measure the thickness of the plank at the 
following three points each along the upper and lower edges: immediately aft of the 
forward scarf, in the centre of the plank, and immediately forward of the aft scarf. You 
will need to work in a variety of views to accurately capture these measurements. 
 
With both the inboard and outboard faces turned on, measure the thickness of the aft 
scarf at three locations along both the upper and lower edges. Moving from forward to 
aft, the values should go from larger to smaller (Figure 11). On forward scarves, the 
values should range from smaller to larger when moving forward to aft (Figure 12). 
 

 
Figure 11. Aft scarf thickness. 
 
 
 

 
Figure 12. Forward scarf thickness. 
 
In the description and repair fields, provide a concise summary of notable features. 
If you notice missed features or types, please fill in the 'Types' field in the database or 
flag up the file as needing additional digital recording.   
 

 

FORWARD SCARF THICKNESS 

Aft Forward

AFT SCARF 
INBOARD 
TABLE 
THICKNESS 

AFT SCARF THICKNESS 

Aft Forward

 52



APPENDIX 10 
 
      3D Digital Solid Modelling Procedures: PLANKS 

 
  *Supplement to the Timber Recording Manual* 

 
 
This is a guide to modelling planks, and is not a hard and fast set of rules.  Each 
timber is different, and will require consideration as to what is being modelled. 
 
Layers are important in this process, and you will need to get used to turning layers on 
and off to enable you to see features better.  The guide does not tell you when to turn 
layers on/off, but you should use your judgement.  
 
Selecting a plank 
 
When beginning to model a plank you should check to see if it is a complete plank, or 
fragmentary. 
 
If it is complete, then begin the modelling process. 
 
If the plank is fragmentary, you should check the relevant strake schematic to ensure 
that you have all of the appropriate pieces, and that they are correctly positioned with 
relation to each other, and the adjacent strakes. 
 
Modelling 
 
Saving file 
 
Once a file has been selected you should click anywhere in open space in the drawing 
window, then select all of the visible data (ctrl-A) and copy the data (ctrl-C).  Open the 
Rhino 3D template NMS Modelling Template 30.06.09.3dm (s:\Modelling\Working 
files\) and paste in the data (ctrl-V).  This will paste only the layers which contain data 
into the file. 
 
Save the file as a new file, in to the appropriate folder in s:\Modelling\Working Files, 
using the standard format of CowTag Function Codes (i.e. 259 P11_5).  If the relevant 
folder is not present, create it using the file tree of s:\Modelling\Working files\ Strake 
number\ cow tag number. 
 
Incremental saving is an important part of the modelling process.  Each time you 
complete a significant stage in the sequence, you should save the file by pressing the 
incremental save icon. This will add a three digit number after the final name (i.e. 259 
P11_5 001, followed by 259 P11_5 002 and 259 P11_5 003, respectively).  
SAVE FREQUENTLY! 
Starting Modelling 
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IMPORTATNT: Before commencing any modelling, go into Rhino and 
check the tolerances (found in Tools/Options/Units/Tolerances). 
Make sure Absolute, Relative, and Angle Tolerances are all set at 
0.000001. This will greatly reduce the incidences of naked edges.  
 
To successfully make a digital solid in 1:10 scale, the file needs to be simplified.  
Begin this by rebuilding the timber edges. 
 
The easiest way to do this is to manually rebuild the plank edges by using the polyline 
function, and placing points along individual edges.  When rebuilding lines it is 
essential to ensure that all of the edges join to another line.  On a standard plank, you 
should model 7 lines on the inboard face: 
 

• Upper edge 
• Lower edge 
• Forward end 
• Aft end 
• Land 
• Scarf upper step 
• Scarf lower step 

 
On a standard plank outboard face you should model 6 lines: 
 

• Upper edge 
• Lower edge 
• Forward end 
• Aft end 
• Land 
• Scarf edge 

 
 
There is no minimum or maximum number of points that you should place on each 
line, you need to use a number appropriate to the timber, to achieve an accurate 
representation of its actual form. 
 
Clearly, fewer points are required on the shorted edges, 4/5 are normally plenty of 
point for the following edges: 
 

• Forward end 
• Aft end 
• Land 
• Scarf edge 
• Scarf upper step 
• Scarf lower step 
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This is done by looking at the timber in front view, and turning on Ortho. 
 
With front view selected, you can rotate the file around to achieve a better angle with 
which to look at the model. 
 
Begin by looking at one of the scarf ends, as these are the areas which usually require 
separation. 
 

Screen Capture of plank scarf showing original edges (Black) and rebuilt curves 
(light blue). 
 
 
Do not model any areas of damage.  Work only with original edges, and skip over any 
areas of limits of original edge.  Be careful not to model any areas of distortion due to 
piling.  This process is very subjective, and it is up to you to ensure that the model 
looks reasonable. 
 
It is best to rebuild the inboard and outboard faces on different layers.  The layers 
Default and Layer 1 are suggested. 
 
 
Separating the lines 
 
Once all of the edge lines have been remodelled, it is necessary to ensure that they 
are at least 10mm apart. 
 
The laser sintering process has a successful resolution minimum of about 1mm.  This 
needs to be accounted for at original scale, so that when reduced to 10th scale the 
model will be a minimum of 1mm think. 



To separate the forward scarf, click a line on the corner of the inboard face, type 10 
and hit return.  This will project a line 10mm long from the point you selected.  With the 
line pointing towards the outboard edge, left click once.  This will place the line.  
Repeat for other points along the forward scarf. 
 
Where the outboard line is closer to the inboard line than the 10mm bar, these need to 
be pulled apart. 
 
This is done by selecting the line to be moved, (the scarf end & upper/lower edges) 
and turning on points (F10) (F11 is points off). 
 
With points turned on it is possible to manipulate the shape & position of the line. 
 
Select end on the Osnap bar. 
 
Select two points at a corner (1 point from plank end, & one point from plank edge) 
and drag these two points to the end of the nearest corner bar.  The line has been 
pried apart at this location.  Repeat until the full scarf is at least 10mm. 
 
When moving points on a corner, it is essential to move two points, as there are two 
lines terminating in the same place. 
 
Repeat the procedure for the other plank end. 
 
 
 
Edges 
 
With the ends of the plank at the minimum 10mm spacing, it is necessary to check that 
the upper & lower edges are also at least 10mm apart. 
 
This can usually be done by a quick visual check, and rarely needs any manipulation. 
 
It is also necessary to place some lines joining the inboard & upper outboard edges to 
act as guides for the modelling process. 
 
These can be done by snapping a polyline directly between the lines.  Try and achieve 
a roughly vertical line. 
 
Only 4 or 5 are needed along the edge of a standard length timber. 
 
Cross sections 
 
Turn on the snit layer for either inboard or outboard, and create some cross section 
lines running across the plank using polyline.  On the fore & aft scarves the sequence 
is: 
 

• Click on either upper/lower edge 
• Click once on snit line 
• Click on other upper/lower edge 
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Anywhere along the land of the plank the sequence is: 
 

• Click on either upper/lower edge 
• Click on snit line 
• Click on land 

END POLYLINE 
 
START POLYLINE 

• Click on land 
• Click on either upper/lower edge 

 
Once the lines are finished, rotate the image so that you can compare the position of 
the lines you just made to the original snit lines; you do not want high levels of 
deviation. 
 
Repeat for opposite face. 
 
It is essential that these polylines are broken along the length of the land. 
 
Always try and keep these lines roughly perpendicular to the plank edges, and use 
positions of snit on the original timber record. 
 
Do not use any snit which goes over areas of damage. 
 
Applying surfaces 
 
With the all of the edges & cross sections modelled, it is time to begin applying 
surfaces to the plank.  It is suggest that a new layer is used for this. 
 
This needs to be done in a sequence, as it will be necessary to break and rejoin lines. 
 
For the standard inboard face there are 4 planes to model: 
 

• Scarf table 
• Scarf lip 
• Plank 
• Land 

 
Use a new layer for these, suggested layer 2. 
 
For the standard outboard face there are 3 planes to model: 
 

• Scarf table 
• Plank 
• Land 

Use a new layer for these, suggested layer 3. 
 
In addition, there are the four edges to model. 
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Use a new layer for these, suggested layer 4. 
 
Begin modelling the edges: 
 

• Select the inboard & outboard plank edge lines 
• Use the sweep 2 rail command 
• Select the bars joining these two lines as the cross sections 
• Hit return 

 
There will now be a digital surface on this edge. 
 
Repeat for remaining 3 edges. 
 
When applying surfaces to the inboard & outboard face there is no set sequence, but 
the plank edges & scarf edges will need to be broken so that the individual facets can 
be modelled. 
 
A suggested method is to: 
 

• Break (snap command) the upper and lower edge lines at the scarf joints 
• Apply surface to scarf 

¾ Select upper and lower edge 
¾ Sweep 2 rail command 
¾ Select cross sections 
¾ Return 

• Apply surface to scarf step (if doing IB) 
• Break the scarf edge/scarf step line by using the land line 
• Break the other end line of the plank using the land line 
• Apply surface to the land 

¾ Select lower (IB) or upper (OB) plank edge and the land 
line 

¾ Sweep 2 rail command 
¾ Select cross sections 
¾ Return 

• Apply surface to plank body 
¾ Select upper (IB) or lower (OB) plank edge and the land 

line 
¾ Sweep 2 rail command 
¾ Select cross sections 
¾ Return 

 
Repeat the process until all of the edge lines have a corresponding surface. 
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Creating a Solid 
 
With all of the digital surfaces visible, and no polylines visible, select all objects (ctrl-A) 
and join them together (ctrl-J).  All of the surfaces should now be joined together, and 
form a digital solid.  
 
This process can occasionally cause a problem known as naked Edges (solution 
below). 
 
Before proceeding make all of the original line drawing visible, and use the Ghosted 
viewport to check that your digital solid plank is a reasonable replica of the primary 
drawing record, and that there is not excessive deviation. 
 

 
Screen capture showing solid model and extend curves on which pipes will be 
created to model the fasteners. 
 
Fixing Naked Edges 
 
Naked edges are primarily formed where two surfaces were made with lines which do 
not quite meet.  This causes a very small gap to form between the separated surfaces. 
 
A less common cause is a slight deviation created by the software. 
 
To view naked edges, use the show edges command. 
 
Any naked edges will be highlighted in pink, if there are no naked edges this will be 
reported in the command line. 
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Join naked edges by using the join edge command. Clicking on a naked edge, and 
then its pair will automatically join them together, and display a report panel on screen. 
 
Deviation greater than 0.99 is unacceptable and will cause problems later.  Deviations 
of this size are usually caused by edges not meeting. 
 
Deviations caused by Rhino are usually of a value to 0.0-13.  It is okay to join these. 

from each end of the original line. Repeat for all connecting lines. 
 
Use the pipe command, to place a 7mm pipe around the nail lines, and at 15mm pipe 
around the treenail lines. Check the pipes against the original fastener lines to ensure 
they have all been modelled correctly. 

 
Screen capture showing the digital solid and the pipes representing fasteners. 
 

 
Once all naked edges have been fixed, check the form of the digital solid against the 
original line drawing. 
 
Nails & Treenails 
 
Modelling the nails & treenails is done using pipes. 
 
Begin with either Nails (Nails layer) or Treenails (treenails layer) 
 
Snap a line between the centre points of a fastener.  If the fastener is not complete, it 
may be necessary to make an estimated projection of the centre point, or no to model 
the fastener.   
 
Repeat for all fasteners on the plank, excluding small additional nails. 
 
Use the extend line command to extend the short connecting line by 100mm from both 
ends.  Click twice in the centre of the line and a 100mm extension will be projected 



Meshing 
 
Before a digital solid can be manufactured into a physical solid it needs to be 
converted into a triangular mesh, though a process called meshing. 
 
Mesh solid 
 
Select the digital solid, and use the mesh command to create a digital mesh of the 
solid.  This will be placed on the same layer as the solid, so move it to the Mesh layer 
by using the object properties command. 
 
Occasionally a mesh can have problems. 
 
Check this by using the check mesh command.  Normally the mesh is okay, but 
sometime it can have non manifold edges, duplicate faces, degenerate faces, or be 
inverted. 
 
Label 
 
Add a label to the model using the text command. 
 
The label should be the cow tag number. 
 
With the model in bottom view, insert the label immediately aft of the forward scarf, in 
roughly the middle of the plank.  Avoid any fastener holes.   
 
Move into front view, and move the text label down so that it runs roughly half way into 
the plank. 
 
Check that this is okay from various angles. 
 
Subtract features from the Solid 
 
The final stage of modelling is to extract the fasteners and label from the mesh, to 
make a solid plank. 
 
Only have the mesh, treenails, nails, and number label visible.  Do not have any of the 
original line date, rebuilt lines, or digital surfaces visible. 
 
Select the mesh. 
 
Use the mesh difference command. 
 
This will remove features from the mesh, and make a digital solid mesh. 
 
Use the check mesh command to check this is okay. 
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represented by a bunch of very small triangles.  If possible, delete the knotted area, 
rejoin the mesh, re fill holes, and re check the mesh. 
 
 
 
 
Remove duplicate faces 
 
To remove duplicate faces, use the extract duplicate mesh faces command. 
 
Recheck the mesh with check mesh, and take any other action necessary to produce 
a good mesh. 
 
 
 
 

Screen capture of the completed digital solid, with fasteners subtracted. 
 
 
 
Remove Non Manifold Edges 
 
To remove non manifold edges, select the mesh and use the remove non manifold 
edges command.  This will extract them from the mesh, but keep them selected.  Hit 
delete to totally remove them. 
 
Use check mesh again, and it should report naked edges. 
 
Select the mesh and use the fill holes command.  This should fill the holes. 
 
Check mesh again and it should be fine. 
 
If not, remove non manifold edges again, but then explode the mesh, using explode 
command.  Check around the areas of non manifold edges for distortion – this is 



Remove Degenerate faces 
 
Remove these with the cull degenerate mesh faces command. 
 
Recheck the mesh with check mesh, and take any other action necessary to produce 
a good mesh. 
 
Change direction 
 
Some times faces can need their direction unifying, do this using the unify face 
direction command. 
 
Recheck the mesh with check mesh, and take any other action necessary to produce 
a good mesh. 
 
If during the difference command to remove the nails etc, they aren’t cut away, but 
added to the mesh, this is because the directions of the mesh and pipes are opposed. 
 
To resolve this, use the flip direction command with the mesh selected.  This can also 
accessed by right clicking the flip direction button. 
 
Scale 
 
Scale the model to 10% by using the scale 3D command, with the object selected. 
 
Click on the work plane, below and to the left of the digital model, then type 0.1, and 
hit return. 
 
The mesh will be scaled to 10% of its original size. 
 
Saving & Exporting 
 
Select the mesh and use the export selected command. 
 
Firstly export this as a *.3dm file to the appropriate file in s:\Modelling\Final 
Rhino\Files.  Use the standard file name format with no additions. 
 
Secondly, export the mesh again as a *.stl to s:\Modelling\ Final STL files ready for 
SLS.  Use the standard file name format with no additions. 
 
Checking the Digital Model 
 
 
Open the *.stl file in MiniMagics.  Rotate the image to ensure it appears okay, with no 
overlapping surface, inversions, or deformations. 
 
Also ensure that there is a green tick in the lower right hand area of the screen – this 
ensures that the mesh is okay for laser sintering. 
 
Use the measure tool just to check that the mesh has scaled correctly. Quit the 
program. 
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Screen capture of a ‘3 mm shelled’ floor cross section as seen in Mini Magic 
software. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Toolbars & Buttons 
 
 
Load the Mesh Editing toolbar, and Solid Modelling toolbar, in addition to the standard 
Timber Recording Toolbar. 
 
Buttons from the Mesh Editing toolbar are: 
 
 

  Applies a mesh to a closed surface object (!_Mesh) 
 

  Checks a meshed object for errors (!_CheckMesh) 
 

  Fills all holes in a mesh object (!_FillMeshHoles) 
 

  Extracts non manifold edges in mesh object  
    (!_ExtractNonManifold) 
 

 Performs a mesh Boolean difference 
(!_MeshBooleanDifference) 

 
 

  Makes a 7mm Radius pipe around a line (!_Pipe) 
 

  Makes a 15mm Radius pipe around a line (!_Pipe) 
 

  Makes a 11.5 mm Radius pipe around a line (!_Pipe) 
 
Additional toolbars and icons can be readily created to 
increase the ease and efficiency of the modelling process. 
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APPENDIX 11 
 

      3D Digital Solid Modelling Procedures: 
Floors and Frames 

 
  *Supplement to the Timber Recording Manual* 

 
Although frames are substantially more complex, and significantly larger than planking 
timbers, the modelling process is fundamentally the same.  The principle of rebuilding 
edges and surfacing individual faces of the timber is the same. 
 
This guide relies upon you having previously read and accomplished the Guide to 
Modelling Planks. 
 
The layering system is again key to this procedure, though is not explicit in when new 
layers should be used – this is up to you to decide.  Use a basic principle of each face 
of the timber at each stage of the modelling process having its own layer.  This is to 
help you to easily differentiate between stages and faces/features. 
 
Selecting a frame 
 
When selecting a frame it is important to ensure that it is complete.  If it is not 
complete, you will need to piece all of the relevant fragments back into their original 
position. 
 
Mast Step/Bracer Alignment 
 
If the frame you are doing is between F25_0 and F34_0, then there will be treenail 
holes on the inboard face which are not connected to the planking.  These were used 
to secure the mast step bracers.  It is important to correctly model the angle on these 
blind treenails, and so you will need to piece the relevant sections of framing timber, 
bracers, and mast step together in a single file before continuing with the modelling 
stage.  With all of the pieces correctly aligned in a single file, snap a line to the centre 
point of a bracer treenail on the inboard face of the frame, and connect this to the 
corresponding inboard centre of the treenail on the bracer.  Repeat until all are done. 
 
If the frame you are modelling is between F22_0 and F50, there may be some blind 
treenails on the inboard face which were used to secure the mast step.  Again, it is 
important to correctly model the angle of these fasteners, and a process similar to that 
for the bracers. 
 
If there are any filler boards associated with the frame, these should be modelled into 
the frame – if possible – and especially where the filler boards are very thin.  
Sometimes it may not be possible, or may not look correct, to model the filler boards 
with the framing timbers. 
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Saving file 
 
Once a file has been selected you should click anywhere in open space in the drawing 
window, then select all of the visible data (ctrl-A) and copy the data (ctrl-C).  Open the 
Rhino 3D template NMS Modelling Template 30.06.09.3dm (s:\Modelling\Working 
files\) and paste in the data (ctrl-V).  This will paste only the layers which contain data 
into the file. 
 
Save the file as a new file, in to the appropriate folder in s:\Modelling\Working Files , 
using the standard format of Cow Tag Function Codes (i.e. 696 F53_0).  If the relevant 
folder is not present, create it using the file tree of s:\Modelling\Working files\ Frame 
number\ cow tag number. 
 
Incremental saving is an important part of the modelling process.  Each time you 
complete a significant stage in the sequence, you should save the file with a new 
name, inserting roman numerals after the file name is suggested. 
 
Starting Modelling 
 
To successfully make a digital solid in 1:10 scale, the file needs to be simplified.  
Begin this by rebuilding the timber edges. 
 
The easiest way to do this is to manually rebuild the frame edges by using the polyline 
function, and placing points along individual edges.  When rebuilding lines it is 
essential to ensure that all of the edges join to another line.  Each of the framing/floor 
timbers are unique in shape, and so it requires some thought and interpretation to 
model the timber.   
 
The minimum number of lines which will need to be rebuilt are: 
 

• Forward face upper 
• Forward face lower 
• Forward face port end 
• Forward face starboard end 
• Aft face upper 
• Aft face lower 
• Aft face port end 
• Aft face starboard end 

 
Most frames have curvature on the inboard face (saddle) and a chamfer around the 
limber hole.  These will require extra lines to be rebuilt. 
 
When rebuilding the forward and aft faces it is necessary to run lines parallel to the 
inboard face from the limber hole to the outboard edge of the face, making a triangle 
between the top of the limber hole, the feet, and the outboard edge.  This will mean 
making smaller surfaces, but produces a better model. 
 
With forward and aft faces rebuilt run some cross sections between the upper and 
lower edges along the lines of snit.  Any time you come to a rebuilt line, stop the cross 
section, and restart again from the same place. 
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For the inboard face no lines need to be remodelled, just cross sections applied 
directly between the forward upper edge and the aft upper edge.  Run these along snit 
lines where possible.  Stopping and restarting the cross section each time a rebuilt 
edge is encountered. 
 
For the outboard face no lines need to the remodelled.  Cross sections can be applied 
directly between the forward and aft lower edges, along the lines of the joggles.  
Rotate the model to ensure that they are accurately reflecting the position of the 
original drawn joggles. 
 
Once all of the edge lines have been rebuilt it is possible to start applying surfaces to 
faces. 
 
There is not set order to this, but lines will need to be broken and rejoined until all 
faces have a surface. 
 
It is possible to surface the outboard face in one sweep, by using the joggle edges as 
cross sections, and the outboard edges of the forward and aft faces as the rails. 
 
Once all faces have a surface, join them together, and using the ghosted viewport, 
check the solid against the original line data. 
 
Fastener Holes 
 
It is only normally necessary to model the treenail fastener holes on the framing 
timbers. 
 
These should be done in the same manner as for planks, but with an 11.5mm radius 
pipe. 
 
Any blind treenails on the inboard face which relate to the mast step, braces, or 
stringers, should be modelled at a 50mm depth (in 1:1 scale). 
 
Occasionally it may be necessary to model some additional spike nails – for filler 
boards for instance – and these should be done as per clinker nails on planks. 
 
Meshing 
 
Meshing the object uses the same procedure as for meshing planks (see guide to 
modelling planks). 
 
Ensure that the mesh looks accurate by comparing with the original line data, and that 
the mesh has no problems by using the check mesh command. 
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Mesh Problems 
 
It is possible that frames will produce more problems than planks, simply bec
there are more surface edges.  However, with the tolerances correctl
template this should not be an issue. 
 
Mesh Boolean 
 
Use the mesh Boolean command to extract a timber number label, and the fastener 
holes. 
 
Again, check the mesh with check mesh command. 
 
Finishing the Solid 
 
Scale the model to 10% by using the scale 3D command. 
 
Check the mesh using the check mesh command. 
 
Export the mesh as both a stl file and 3dm file, to the appropriate locations with the 
appropriate file name. 
 
Check the files with MiniMagics. 
 
Convert to 3D PDF if desired. Use Abobe Standard, not the Geomagic shortcut. 
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